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I
n mid-August, ISR initiated a
new service that allows Buck-
nell users access to their email
account using a web browser
from any computer attached to

either Bucknell's network or the Inter-
net. This service, called WebMail, can
be used by pointing your web browser
at https://webmail.bucknell.edu. The
login page requires your username and
email password. After login, you can
read mail messages stored on the 
mail server, respond, and create new
messages. Some of the more advanced
features of WebMail allow you to spell
check messages, filter messages into
different mail folders, and maintain an
address book. In essence, it can do all
the functions that an email account
on Yahoo! or HotMail can, with some
added benefits. Unlike these commer-
cial services, all traffic between your
web browser and Bucknell's WebMail
server is encrypted. As a result, it is
nearly impossible for a person to read
an intercepted message or password.
In addition, since WebMail uses Buck-
nell's mail server to store and retrieve
email, your email quota is usually
much larger than the commercial 
services (Bucknell's current email
quota is 100 Mb of messages).

In the spring 2002 semester, a

group from ISR and the
Engineering Computing
and Support Team
started a project to
determine the
best available
product for
Bucknell's
Webmail
service. The
WebMail service
in use today was chosen based on
input from faculty, staff, and students. 

The popularity of this service has
proven very surprising: at peak times
the WebMail server will handle over
250 simultaneous connection
attempts. While the server hardware
easily accommodated this traffic, the
default software configuration
required some tuning. As a result,

there were initially some brief,
unplanned WebMail outages. Further,
the popularity of the WebMail server
has added an additional load to Buck-
nell's main email server. These 
problems are constantly reviewed 
and fixed.

The WebMail Help System was
identified in the pilot project as a
weakness. ISR is currently working to
incorporate a custom help system into
WebMail (http://libweb.bucknell.edu/
Computing_On_Campus/E-mail_sup-
port/Using_webmail).  A number of
enhancements for WebMail are being
assessed for feasibility: incorporation
of a mechanism for changing an email
password, email quota determination,
and integration of the Vacation Mail
and Mail Forwarding interfaces into
WebMail.
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In essence, it can do 

all the functions that 

an email account on Yahoo! 

or HotMail can, with some

added benefits.

Bucknell’s New WebMail Service
By Michael Dahlberg, Systems Integrator
Dahlberg@bucknell.edu
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The Leadership Imperative
By Gene Spencer, Associate Vice President for Information Services and Resources
gspencer@bucknell.edu
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W
hen has leadership helped you to be more
effective?  What are the most critical charac-
teristics of good leadership? How can leaders
best support your work?  What are your
hopes and dreams for effective leadership?

These are interesting questions that I hope you will find
worthy of your time and reflection.

Earlier this summer, I was faced with the prospect of
reorganizing the leadership structure within ISR to best 
prepare us for the opportunities and challenges that lie
ahead.  Although we have a culture that values leadership
at all levels, it was clear that we needed a relatively 
simple structure that could be easily understood and that
supported the work of our extraordinary staff.

During the months of May and June, I invited everyone
in ISR to reflect on the questions posed above and to help
me understand the elements of leadership that were the
most important to them. Sixty-five people accepted the
invitation. The resulting conversations provided a wealth of
insights and ideas, most of which have formed the founda-
tion for thinking about a new leadership team for ISR.

ISR’s primary function is to create an information and
technology environment that best serves the campus. Not
surprisingly, there is much that takes place behind the
scenes to pull that all together. Our people, our ideas, our
resources, our advisory committees and the feedback from
the campus community must all be integrated to design and
build the kind of environment that will best serve your
needs. For me, that integration is the key to making it all 
fit together.  

Our new leadership team, launched in August 2002, is
built on the theme of integration. Three new directors are
now responsible for helping ISR to integrate its activities
into a cohesive whole. They are also responsible for helping
to integrate our efforts, resources and services into the aca-
demic, administrative and co-curricular work of the campus.
I feel extremely fortunate to have three gifted and dedicat-
ed leaders to serve ISR in these new roles.

Nancy Dagle has become our new Director of Information
Integration. Nancy came to the Bertrand Library in 1985,
when she assumed leadership for the library’s technical 
services. She has a BA in French Literature from Brown 

University, an MA in French Literature from Columbia Uni-
versity and an MS in Library Science from Simmons College.
Nancy brings to the campus a long history of work within
the library community and a commitment to providing high-
quality information resources in a highly efficient manner.

Brian Hoyt is our new Director of Technology Integration.
Brian has worked at Bucknell over the past decade, leading
many efforts to leverage the advantages of technology in the
teaching/learning environment. He holds three degrees from
Bucknell University (a BS in Electrical Engineering, a BA
College Major, and an MS in Electrical Engineering), as well
as an MS in Instructional Technology from Bloomsburg Uni-
versity.  Brian is devoted to finding new ways for technology
to help people tackle problems they couldn’t otherwise
solve, and in planning strategically for the future.

Jeannie Zappe is our new Director of Service Integration.
Jeannie joined the computer center in 1989, where she has
provided years of leadership for our front-line technology
support efforts. She holds a BS in Quantitative Business
Analysis from Penn State University and an MS in Business
Administration from Bucknell University. Jeannie brings 
a passion for providing excellent service and improved 
communications with the campus community.

I am excited about the leadership that Nancy, Brian 
and Jeannie will provide for ISR and for the campus in 
the months and years ahead. Their job descriptions state
explicitly “to be successful, you must have a passion for
professional development that includes developing leader-
ship qualities in yourself and others.” I cannot think of
three individuals who are better suited for that role!

I will leave you with one additional thought about 
leadership. In the course of a single week not too long ago,
several colleagues referred me to a new book called Primal
Leadership: Realizing the Power of Emotional Intelligence
by Daniel Goleman, Richard Boyatzis and Annie McKee. As
the book describes, “intellect alone will not make a leader;
leaders execute a vision by motivating, guiding, inspiring,
listening, persuading – and, most crucially, through 
creating resonance.”  If you serve as a leader in any way 
or in any role, I strongly recommend this book. It may
change your life.  

Gene 



person who sent the message. By
clicking on the “Blah Blah Blah” icon
on your Eudora toolbar, you’ll be able
to see the complete header for the
email message. In the message from
the example above, the header looks
like this:

Return-Path:
<GENOMA@mail.ono.es>
Received: from antigen.bucknell.edu
(antigen.bucknell.edu [134.82.9.20]
by marge.bucknell.edu
(8.12.4/8.12.4) with ESMTP id
g9HFF1cN003911
for <dhiller@bucknell.edu>; Thu,
17 Oct 2002 11:15:04 -0400 (EDT)
Received: from mta02.onolab.com
(smtp.ono.com [62.42.230.12])
by antigen.bucknell.edu
(8.12.4/8.12.4) with SMTP id
g9HFE0Qm007044
for <dhiller@bucknell.edu>; Thu,
17 Oct 2002 11:14:01 -0400 (EDT)
Date: Thu, 17 Oct 2002 11:14:00 -
0400 (EDT)
Message-Id:
<200210171514.g9HFE0Qm007044
@antigen.bucknell.edu>
Received: from Zdzdxbpi
([62.42.8.29]) by mta02.onolab.com
(Netscape Messaging Server 4.15)
with SMTP id H44SYG00.UC7 for
<dhiller@bucknell.edu>; Thu, 17
Oct 2002 17:13:28 +0200 
From: daccess
<daccess@microsoft.com.ve>
To: dhiller@bucknell.edu
Subject: {VIRUS?} A very humour
game

What does all of this mean? Well, it
traces the path of the email message,
including its trip through
antigen.bucknell.edu, which is our
anti-virus mail scanner, and
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S
ince this summer, the Tech-
nology Desk has received a
number of calls from faculty
and staff who are not 
sure what to make of the

messages in their email inbox. 

Subject: {VIRUS?} A very humour
game.

The email will go on to say something
like: 

Content-Type: text/html;

This is a humour game
This game is my first work.
You're the first player.
I hope you would enjoy it. 

--------------------------------------------
The remainder of this message is
from the Bucknell University E-Mail
Virus Protection Service
--------------------------------------------
The e-mail message above contained
an attachment "rock.exe"which was
believed to be infected by a virus.
This attachment has been deleted
and has been replaced by this 
warning message.

Is it a virus? Are you safe or are you
infected? What does this message
mean and why have you received
dozens of messages like this since the
end of June? The answer to the
biggest question is yes, you are safe –
the message that you have received is
an indicator that our anti-virus scan-
ning software is doing its job.  On
average, it has been doing this job
over 700 times a day across campus!

In June of 2002, we implemented
an email anti-virus scanning service.
All email that comes in to Bucknell
email accounts or that is sent by
Bucknell email accounts is automati-
cally scanned for viruses. Mail actually
goes through a server that scans for
viruses or attachments that typically
spread viruses. These attachments
have such extensions as .reg, .chm,
.cnf, .hta, . ins, .jse, .lnk, .pif, .scf,
.scr, .sct, .shb, .shs, .vbe, .vbs, etc.

In the example shown above, what
the message is saying in the subject
line is “there may be a virus attached
to this message.” In the body of the
message, there are a few words that
are included with the message to try
to get you to click on the attached
file. The file itself, however, has been
deleted by our virus protection 
service. The warning message goes 
on to say that, if the message came
from a friend of yours, you should
contact that person to let him or her
know that you received an attachment
that contained a virus. Most likely,
you didn’t recognize the return
address. In either case, you have not
received a virus at this point – you
have merely received notification that
a virus was attached to a message that
had been sent to you, but the virus
was deleted. You can just delete the
message.

On a related question, some people
have wondered how they seem to be
sending out viruses when they have
Norton Anti-virus installed and up-to-
date.  The answer can be found in the
insidious nature of computer viruses.
The person or address listed in the
From: line very well may not be the

by Bud Hiller, Web Access Consultant
dhiller@bucknell.edu

VIRUS, ANTI-VIRUS

continued on page 9
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M
y name is Jason Snyder,
and I am the new
Humanities Librarian
here at Bertrand
Library. I will be 

collaborating with Humanities faculty
in the areas of collection develop-
ment, user education, and enhancing
access to Humanities information, in
print as well as digital formats. I am
also responsible for coordinating the
media collection (DVDs, videos,
laserdiscs, CD-ROMs, music compact
discs, audio cassettes, vinyl LPs, and
beyond!). Another duty that I am very
much looking forward to is participat-
ing in the new ISR Representative 
program. I am especially happy to
work for an organization such as ISR,
where collaboration, ideas, innovation,
flexibility, and service are so highly
valued.  

It is exciting to be back at 
Bucknell; I was an undergraduate and
graduate student here, graduating in
1995 and 1998, respectively, and I
worked here in the library as a refer-
ence assistant! During my time here 
as a student, I was an English major
(with an education minor), and had
the opportunity to learn from many
great professors. When I arrived back
on campus in early October, I was
amazed at the changes in the campus,
both physical and curricular, that have
taken place in the four short years
since I graduated. This is a beautiful,
dynamic, and vibrant community, and

A New Humanities Librarian

By Jason Snyder, Librarian/Information Specialist for the Humanities 
jcsnyder@bucknell.edu

for a lack of better words, it’s great to
be back!

I return to Bucknell by way of 
Middlebury College, where I worked 
as Electronic Services/Reference and
Instruction Librarian, and the Univer-
sity of Maryland, College Park, where 
I was Manager of the Instructional
Development and Support Center in
the College of Information Studies
(also known as the library school),
while working on my Master of Library
Science degree. In these positions, I
gained experience in reference, user
education, collection development,
creating research guides, Web design,
usability testing, and so on. Working
in libraries at both a huge state uni-
versity and a small liberal arts college
has given me a unique set of experi-
ences and skills that will enrich the
work that I do here at Bucknell.  

I am a native of the Susquehanna
Valley; I grew up in Mifflinburg, so
this truly is a homecoming for me.
Not only have I returned to the area
where I spent my formative years, but
also to the institution and organiza-
tion that were integral parts of my
academic and professional develop-
ment. I am absolutely delighted to
have the opportunity to contribute to
the academic community that gave so
much to me. 

Please stop by when you are in the
library and say hello!

Jason Snyder
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O
ur campus community
depends on the use of 
several campus-wide email
lists for communication.
However, because of the

amount of email that we all receive in
today’s electronic communication
environment, it’s important that we
know how to use these lists appropri-
ately and judiciously. Did you know
that messages posted to the campus
lists such as CAMPUS, STUDENTS, and
FACSTAFF must follow specific guide-
lines?  Please read on to become more
aware of how, when and why you
would want to use our campus email
distribution lists to communicate with
the campus community.

About the campus-wide lists
All of our campus-wide lists

(please see the Campus-wide list
addresses quick reference below), with
the exception of the faculty list, are
distribution lists moderated by ISR,
meaning every message that is sub-
mitted to the list must be approved
before it is distributed to ensure that
messages meet list use guidelines and
abide by the Appropriate Usage Policy
(http://www.isr.bucknell.edu/Rights_
and_Responsibilities/aup.asp). In
addition, these lists are distribution
lists, not discussion lists, so they may
not be used to conduct a discussion.
The faculty@bucknell.edu list is a
closed, unmoderated discussion list for
members only, meaning messages flow
freely without intervention from ISR
and message delivery is usually rapid. 

Message delivery expectations
Message delivery is typically with-

in one business day, although it can
take longer if messages possibly vio-
late the Appropriate Usage Policy, are
resource-wasteful, or do not include
the appropriate information (See
Information guidelines below). ISR
makes every effort possible to moder-
ate the lists during normal workday
hours, 8:30 a.m. to 4:00 p.m. week-
days. This can vary somewhat due to
staffing demands and emergencies.
When posting to any of the lists,
please keep in mind that it can take
an hour or more to reach the modera-
tor if the list is busy, as it usually is
in the afternoon. 

Due to the large number of posts
that are submitted to the lists, our
policies prohibit reminders of meeting
announcements for groups that meet
on a regular basis. Reminders of
events can be posted to the lists as
long as the reminder is posted at least
one week from the original announce-
ment. In addition, Lost & Found, For
Sale, and Ride Information messages
cannot be posted. 

Information guidelines
All messages must have a subject

line that pertains to the announce-
ment, or the message will be refused.
If this happens, you will be notified
and asked to resend the message.
This can delay the posting, so please
try to avoid this whenever possible.
Messages posted to lists should not
contain any advertisements for the

email client you are using, or they
will be rejected. Messages that could
be considered controversial, or may
provoke a discussion, are not allowed
to be posted to these lists. All 
messages must also be sent from a
Bucknell email address.

When posting event announce-
ments, please include the name, loca-
tion, sponsor, date and time, cost of
the event, and the recipient of any
proceeds. Events must be sponsored
by an officially recognized Bucknell
organization or one that is in the
process of forming.

In order to use copyrighted 
pictures or other material, users must
have been granted copyright permis-
sion to be used for this purpose. 
Messages containing copyrighted
material used without permission will
be rejected.

Size limitations
Messages can be no larger than

50k in size, which includes any
attachments to the message. If you
find your message getting too large 
to send, you may want to consider
putting your information up on a web
site and sending the URL instead of
the entire message. 

Formatting guidelines
Please keep in mind that format-

ting (colors, links, pictures, etc.) may
not be able to be viewed by all email
applications being used on campus.
Format your email message sparingly. 

Mail, mail, and more mail…
all about our campus email distribution lists

By Jeannie Zappe, Director of Service Integration
jzappe@bucknell.edu
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Campus-wide list addresses quick
reference 

■  faculty@bucknell.edu – Includes all
faculty, retired faculty by request,
and non-faculty receiving faculty
meeting minutes. 

■  facstaff@bucknell.edu – Includes all
faculty, all administrative and sup-
port staff, and retirees by request. 

■  campus@bucknell.edu – Includes all
faculty, all administrative and sup-
port staff, all students, and retirees
by request. 

■  students@bucknell.edu – Includes
all undergraduate and graduate 
students. 

■  firstyear@bucknell.edu – Includes
all first-year students. 

■  sophomore@bucknell.edu – Includes
all sophomore students. 

■  juniors@bucknell.edu – Includes all
junior students and sub-senior 
students. 

■  seniors@bucknell.edu – Includes all
senior students. 

■  graduates@bucknell.edu – Includes
all graduate students. 

■  faculty-announce@bucknell.edu –
Includes all faculty, retired faculty,
and non-faculty who receive faculty
minutes. This list should be used 
by non-members of the faculty
@bucknell.edu list who need to 
distribute an announcement specific
to the faculty. 

■  admin@bucknell.edu – Includes 
all administrative staff. This list
should be used sparingly, as most
announcements probably pertain 

to the campus
(campus@bucknell.edu), or to all
staff (facstaff@bucknell.edu). 

■  support@bucknell.edu – Includes all
support staff. Again, this list should
be used sparingly, as most
announcements probably pertain to
the campus (campus@bucknell.
edu), or to all staff (facstaff@buck-
nell.edu). 

With the exception of the faculty
discussion list, these are distribution
lists and should be used accordingly
by the campus community.  At no
time should the lists be used to con-
duct a discussion.  Please note that
the above lists can be "opted out" of
by a member of the community, so
they are not necessarily all-inclusive.

For more information
For more information, please visit
Bucknell's email list web site:
http://www.isr.bucknell.edu/Comput-
ing_On_Campus/E-mail_lists/. To view
the web archives (previous postings)
for the campus-wide email lists, visit:
http://www.isr.bucknell.edu/Comput-
ing_On_Campus/E-mail_lists/archives.
asp.

Thank you, in advance, for using
these lists according to the recom-
mended guidelines, so that we can all
communicate quickly and well.

7:45 AM Opening Hour
for Bertrand Library

by Isabella O’Neill, Librarian/Manager
of Reference Services Program 
ioneill@bucknell.edu

Information Services and Resources

(ISR) is pleased to announce that the

Bertrand Library doors will be opened

15 minutes earlier, at 7:45 a.m. Mon-

day through Friday, to accommodate

your needs before 8:00 a.m. classes 

or office obligations.  The change in

hours began Wednesday, October 23rd

and will remain in effect throughout

the calendar year, including academic

breaks and inter-sessions.  Circula-

tion/Reserves/ Equipment staff will be

available to check out material and

equipment.  The Technology Support

and Reference/Information Desks will

be staffed beginning at 8:00 a.m. 

Please check for additional informa-

tion about Bertrand Library hours on

the ISR web site at www.isr.bucknell.

edu/Building_and_Service_Informa-

tion/hours.asp.  

If you have any questions regarding

Bertrand Library hours, please feel

free to contact the ISR Office at

x71557.
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W
hile Acrobat Reader is
a wonderful program
for viewing pdf docu-
ments, if you have the
full version of Acrobat,

you can also create documents that
will be more useful and navigable for
your users with just a few moments 
of editing.

DOCUMENT OPEN OPTIONS
Have you ever had a document

open up so large that it filled your
screen? You could barely see any part
of the document without scrolling all
around it! Acrobat allows you to con-
trol the magnification at which your
document will open, and it will open
that way for every person who access-
es the file, whether it is on the web,
on a single computer, or on a net-
work.  To do this:
■ Open the document in Acrobat 

(all of these tips require the full
version, not Acrobat Reader).

■ Click on File>Document proper-
ties>Open options.

■ Click on the pull down menu for
Magnification.

■ Select your preferred viewing
option. Experiment with different
styles – usually, you can select
from Fit in Window, Fit Width, or
Fit Visible. I find that Fit in 
Window allows users to see the
whole page – if they need to, they
can easily click on the magnifying
glass or hit the Z key to zoom in

on an area they would like to see
enlarged.

■ Click on File>Save As and save the
file. The next time that you or any-
one else opens it, it will open with
the exact magnification that you
prefer.

NOTE: A related tip – Always use
File>Save As in Acrobat, even if you
are saving the file with the same file
name.  By default, Save As will 
optimize the file for fast web access,
eliminate duplications in pages and
backgrounds, and make for a smaller,
faster-loading file.

ADD OR CHANGE A BIT OF TEXT?
Many people realize that Acrobat

is not an editing program. If you are

looking at a pdf document and you
would like to move text, add para-
graphs, etc., you should really do all
of that in your original Word or Page-
maker document, then recreate your
pdf document. But sometimes you
need to make only minor changes:
alter a date or a name, add a small
amount of explanatory text, insert a
single line. That is possible with 
Acrobat 5, and very easy to do.

To change a few words on a page, or
to insert a line of text:

Click on the TouchUp Text tool,
which is the T-shaped icon on the
toolbar. Note that the hand tool has
become an I-beam. Note also that if
you are viewing a pdf image, which is
basically a picture of the page, you

By Bud Hiller, Web Access Consultant
dhiller@bucknell.edu

Acrobat 5.0
tips and tricks!



will not be able to select or highlight
any text in the document. Click where
you would like to type a letter, or
highlight text you would like to
change.  Note that you cannot select
multiple lines – this feature is for very
limited editing only!  If you would
like to insert a line on a blank area of
the page, hold down the control key
after selecting the TouchUp Text tool
(option key on a mac) and click on
your page.  A blinking insertion point
will appear – type your text, select
Save As, save your file, and you have
edited the document. If you would
like to change the attributes of this
text (font, type face, color, etc.),
highlight the text after selecting the
TouchUp Text tool, right-click, select
attributes, and make the changes 
you desire.
To insert a larger amount of text:

Acrobat 5 has a number of fea-
tures that allow you to make your
document more flexible. One of them
is the Free Text tool. Click on the
down arrow next to the Note tool on
your toolbar and select the Free Text

tool. Your mouse pointer will change
from a hand to an object that you can
use to draw a box – click and drag the
pointer to create a box that is the size
that you desire. You will have a blink-
ing insertion point and you can begin
to type in your text. Be careful –
until you change your mouse back to
the hand by clicking on the Hand tool
or typing h, every point that you click
on your document will become a Free
Text box! You can delete any unwant-
ed boxes, or change the color of the
font/border or change the font
size/color, by right-clicking on the
box while using either the Hand tool
or the Free Text tool and selecting
either Delete or Properties.

Acrobat has many other features
designed to enable the creator of the
document to make it more friendly,
more usable, and much more navigable
than many other formats. You can
quickly and easily create bookmarks
to enable users to instantly click and
advance to other pages in a document,
make links to web sites or other spots
in the document, create thumbnails of

pages, and move pages around in a 
document or even into another doc-
ument. The Acrobat help guide is
well written and concise – in fact,
if you open it up (by clicking on
Help>Acrobat help) you will see 
an excellent example of the use of
bookmarks to make a 287-page 
document instantly more accessible. 

If you have questions about
these tips or any other Acrobat
issues, please contact Bud Hiller at
dhiller@bucknell.edu or 73288.

continued from page 4 “Virus”

marge.bucknell.edu, which is our email server.  But you can
see that while the From: line says it is from daccess@
microsoft.com.ve, the header says that the message was
Received from mta02.onolab.com. Whoever daccess is, he or
she likely didn’t send the message. What viruses frequently
do is attack someone who is not protected, and go into the
email address book of the victim. The names in the address
book are then placed in the From field of virus-infected
emails, which is why you will occasionally find infected
email that appears to be from someone you know when, 
in fact, it is not. Bucknell’s anti-virus scanning service 
eliminates many of the problems that can arise from people

unknowingly clicking on attachments that infect their own
machines by eliminating the virus before it even shows up in
your inbox!

Viruses can wreak havoc on users and the campus as a
whole – ask anyone who has had to re-image their computer
in the middle of the semester because a virus has made their
data inaccessible. So if you receive a message that tells you a
virus has been intercepted, you can happily delete it while
feeling secure that at least that particular little worm didn’t
make it into your Apple (or Dell, or Gateway!).
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By Bud Hiller, Web Access Consultant
dhiller@bucknell.edu

Faculty and staff users of the SPSS software can pick up a disk with the 11.5 update at the Tech Desk, or contact the Tech
Desk at x77777 to request installation on their Windows computer.

New features include:

■ All new tables – create tables more easily, preview your table, control output, customize data display by adding 

subtotals, changing variables, etc.

■ Export your SPSS data files directly to SAS or save SPSS files as .sas syntax.

■ TwoStep Cluster analysis identifies clusters in your data with state of the art algorithms.

■ Export pivot tables directly to Excel.

■ Export SPSS output directly to Word.

■ Improved navigation through SPSS with the mouse wheel scroll.

SPSS 11.5 for Windows now available!
SPSSSPSS

Check Out PALCI

By Lona Sholly, Library Assistant, Borrower Accounts
sholly@bucknell.edu

Did you know that you can order a book on Monday from another Pennsylvania academic library and have it arrive before

the end of the week, possibly as early as Wednesday?  That is an advantage of PALCI, the Pennsylvania Academic Library 

Consortium, Inc.  A request for a book triggers a simultaneous search of over 40 academic library catalogs.  If the book you

want is not available at Bertrand Library, you can initiate a request to borrow it.  It only takes minutes to place a request,

and will save you a trip to another library. 

This service was temporarily interrupted in August while we converted to a new library system, but PALCI is again avail-

able to faculty, staff and students at http://palci.library.pitt.edu/~ursa/BUCKNELL_login.html   Or you can find the link 

provided on the ISR web page by clicking on Other Library Services > Interlibrary loan > Submit a PALCI Request.



Help for last minute researchers

By Jen Perdue,
perduej@bucknell.edu
Candice Hinckley, Borrowing Coordinator, Interlibrary Loan
chinckle@bucknell.edu
Kathleen McQuiston, Librarian/Program Manager for Information Resources Selection
mcquisto@bucknell.edu

Conversation overheard between a harried student and a reference librarian:

Yes, I can assist you with your research needs, even though your paper is due tomorrow.  No, don’t be embarrassed,
many of your fellow classmates have been in today in a similar situation.  Let’s talk about your paper and I will help you
identify appropriate resources relative to your topic.  No, you don’t have to limit your sources to those that we have here
in the building, although the library collection is extensive and I’m sure that you’ll find many items that will work. 
In addition, most of the full-text articles listed in the databases below are available to you from your dorm room or a
campus computer lab.  Relax, I’ve been in this business a long time and have been specially trained for situations just
like this one.  We’ve extended our hours, so you won’t have to rush.  

Bucknell students can relax and feel confident that there is always a staff member at the Reference Desk ready
to assist him or her in finding resources and information.  We help students focus, identify appropriate materi-
als, and point out those that we have on hand in the collection or available full-text online. And, we have
extended hours during final exams week.  

Here’s a partial list of the full-text databases that are available:

ArticleFinder - Our primary undergraduate journal article database. Includes some full text articles. Normally
you should begin your search for journal articles here.

Research Library Complete - Citations and full-text of newspaper and periodical articles covering a broad
range of subjects, including arts, business, humanities, social sciences, and sciences.

Lexis-Nexis Academic Universe - Full-text access to legal, news, business, medical, and reference 
information.

JSTOR - An archive of core, scholarly journals from a variety of subject areas. Coverage begins with the very
first issue through all but recent years.

National Newspapers - Full-text articles from 27 newspapers, including the New York Times, Wall Street 
Journal, and Washington Post, plus other important United States, international, and minority-interest papers.

Wilson Select Plus - Full text articles in science, humanities, education and business.
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ISR Quick Reference
If you are off campus, please dial 570-57 before each extension. 

Circulation Desk  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .71882
ISR Office – 221 Bertrand Library  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .71557
ISR Office – 101 Computer Center . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .71795
Library Hours  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .71881
Reference/Information Desk  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .71462

Email the Reference Desk  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Ref1@bucknell.edu
Reference by Appointment  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Ref1@bucknell.edu
RefDesk Live.....follow the links for Help Options ➔ Chat with the Reference Desk

Electronic Reserves  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Bud Hiller......dhiller@bucknell.edu.....73288
Reserves  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Barbara Stockland.....bstockla@bucknell.edu.….73294
Scheduling a computer lab  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .reservelab@bucknell.edu
Software Service Clinic  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .ssc@bucknell.edu.....77777
Technology Desk  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . helpdesk@bucknell.edu.....77777

TechDesk Live.....follow the links for Help Options ➔   Chat with the Tech Desk
Equipment for check-out  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Marcy Siegler.....siegler@bucknell.edu.....77733
Telephone repairs, billing, voice mail  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .71810
User Education and training

Computing  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Lisa Veloz.....lveloz@bucknell.edu.....71796 
Library  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Judy Zebrowski.....zebrow@bucknell.edu.....73242

Web development  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .Roberta Sims.....rsims@bucknell.edu.....73310

Wandering our Web site...
FAQs
The Frequently Asked Questions (FAQ)
section of the site provides answers to
the questions we get asked the most,
concerning our many services and
resources. The questions have been
divided up into categories that corre-
spond to the main areas of the ISR
site. Keep on the lookout for FAQs to
be featured at convenient locations
throughout the site. To browse
through the ever-growing list, click
the FAQs link that can be found in
the black bar near the top of every
ISR web page.

ISR Staff Directory
Visit the ISR staff directory to learn
more about ISR staff members and the
workgroups that make up our depart-
ment. You can search the directory,
browse by last name, or browse by
workgroup. In addition, the staff
directory includes links to pages that

can assist you in determining who is
your ISR Representative and Library
Liaison. A link to the ISR Staff 
Directory can be found in the black
bar near the top of every ISR webpage.

Help Options
Our help options menu provides links
to ways to get help online. The menu
features links to Chat with the Refer-
ence Desk (RefDesk Live) and Chat
with the Technology Desk (TechDesk
Live) services, as well as links to email
either desk. Also included in the Help
options menu is the classroom emer-
gency telephone number that can be
called for immediate service when
technology fails during a class. A link
to Help Options can be found in the
black bar near the top of every ISR
web page.

Outage and Alert Center
The Outage and Alert Center includes
up-to-date information regarding sys-
tem, network and service availability.
It provides information about protect-
ing your computer from viruses, and
network maintenance tips.  Current
outages and alerts can be found at the
top of the front page of the ISR web-
site.  To find out more about the cen-
ter or browse through our outage
archive, click Viruses and outages
from the Computing on Campus
section of the ISR web page.

Online Manual Collection
ISR provides access to a collection of
online technology manuals. The col-
lection includes books on Microsoft
Office, Dreamweaver, Java, Perl, Linux,
Unix and more.  It can be browsed by
selecting Guides and Manuals from
the Learning Technology Skills
section of the ISR website. 
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